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Important Notice 

This manual is subject to the following conditions and restrictions: 

• This User's Manual provides documentation for the PowerTerm® WBT 

product. Your specific PowerTerm product might include only a portion of the 

features documented in this Manual. 

• The proprietary information belonging to Ericom® Software is supplied 

solely for the purpose of assisting explicitly and properly authorized users of 

PowerTerm®. 

• No part of its contents may be used for any other purpose, disclosed to any 

person or firm, or reproduced by any means, electronic and mechanical, 

without the express prior written permission of Ericom® Software. 

• The text and graphics are for the purpose of illustration and reference only. 

The specifications on which they are based are subject to change without 

notice. 

• The software described in this document is furnished under a license 

agreement. The software may be used or copied only in accordance with the 

terms of that agreement. 

• Information in this document is subject to change without notice. Corporate 

and individual names and data used in examples herein are fictitious unless 

otherwise noted. 

 

Copyright© 2000 – 2007 Ericom® Software 

Ericom® and PowerTerm® are registered trademarks of Ericom® Software, which 

may be registered in certain jurisdictions. Other company and brand, product and 

service names are trademarks or registered trademarks of their respective holders. 
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1. Introduction 

This chapter presents PowerTerm WBT and its main features. It also describes the 

basic steps on how to use PowerTerm WBT for users who are familiar with 

accessing remote terminals.  

This chapter includes the following topics: 

• What is PowerTerm WBT? 

• PowerTerm WBT Features 

• Getting Started 

1.1. What is PowerTerm WBT? 

PowerTerm WBT is a fully functional terminal emulator for Microsoft Windows-Based 

Terminal. It emulates various terminal types, including IBM, UNIX, HP, VMS and 

Tandem. PowerTerm WBT enables you to connect to a single or to multiple hosts 

via both network and serial or modem connections. PowerTerm WBT's Session 

Manager provides quick access to a list of user-configured sessions. 

PowerTerm WBT has two main features to enable the WBT to act and feel like a real 

host terminal: 

• Terminal display emulation, PowerTerm WBT emulates the exact display of the 

chosen terminal. It presents host applications precisely as they would appear 

on the terminal. Once the WBT connects to a host computer, all host 

operations can be performed as if the WBT is an actual host terminal. 

• Terminal keyboard emulation, PowerTerm WBT enables you to emulate the 

selected terminal's keyboard by mapping the WBT keys to match the host 

keys. Keyboard mapping definitions are stored in the registry. 

PowerTerm WBT also provides various options to customize and optimize the 

working environment such as: 

• Power Pad, a programmable floating keypad. 

• Soft buttons, programmable buttons located at the bottom of the PowerTerm 

WBT window. 

• PowerTerm Script Language (PSL), a full-featured programming language, 

which enables you to create scripts for automating tasks. For example, you 

can create a PSL script for automatic login. Scripts can be used at startup of 

PowerTerm WBT, or can be utilized any time during a PowerTerm WBT 

session. PSL commands can also be assigned to the Soft buttons and/or the 

Power Pad to enable additional functions with a click. 
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1.2. PowerTerm WBT Features 

PowerTerm WBT features include: 

• Compact, light and high performance program 

• Supports TCP/IP 

• Supports RS-232 

• PowerTerm Script Language (PSL) 

• Session Manager (for Standard edition only) 

• Macro recorder for automation of tasks 

• Enables you to save parameters for all sessions 

• Language support for all Western European languages 

• User programmable buttons 

• Floating Power Pad with programmable buttons 

• Control of color selection and screen attributes 

• Easy to use keyboard mapping 

• SCS Printer emulation 

• Setup replication 

• Online help (only upon request) 

1.3. Getting Started 

1.3.1. PowerTerm WBT Setup 

To enable WBT-host interactions, you need to define two sets of parameters: 

• Terminal parameters 

• Communication parameters 

All parameters are saved in the registry. For more information about specifying and 

saving parameters, see chapters Defining Emulations and Defining Connections. 

PowerTerm WBT provides the option to work with a single host or with multiple 

hosts. You can create different setup configurations for working with each host to 

enable each user a customized working environment. Each one is saved in the 

registry. 

Working with a Single Terminal Connection 

When you launch PowerTerm WBT from the Connection Manager, it automatically 

uses the parameters in the setup configuration that you choose. 
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Working with Multiple Terminal Connections 

If you are working with different terminals with different emulations, you may need 

to use a different setup for each emulation. To create a specific setup, you first 

need to create a new session (with its communication parameters) using the 

PowerTerm WBT Connection Manager. After this is accomplished, you launch this 

newly created session and define the terminal setup and save it. Theses setups will 

reside in the registry from where they will be loaded upon launching the session. 

1.3.2. A Quick Guide through PowerTerm WBT 

 

Step 1: Create a Connection Entry 

For a full description of creating connections and specifying emulation parameters, 

see chapters Defining Connections and Defining Emulations 

1. Open the Connection Manager and click Add. The New Connection dialog 

appears. 

 In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Add button. 

2. Select Ericom PowerTerm WBT – Terminal Emulator (or the name that was 

predefined by the OEM). 

3. Click OK. The Connection Properties dialog appears. 
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4. Specify your emulation type and necessary parameters. 

5. Type the Connection Name. This name automatically appears in the Setup 

Name field. 

6. Configure the Terminal, GUI, and/or Keyboard Setup options as desired. 

7. Click OK. The new connection appears in the Connection Name list of the 

Connection Manager. 

Step 2: Connect to Host 

You can either select to connect to the terminal session you have just defined or 

connect to a previously defined connection. 

Select the desired session and click Connect, or double-click on the selected 

session. The connection is established. 

Step 3: Work with the Host 

Once you have connected to a host, PowerTerm WBT enables you to work as if you 

are working from a terminal. PowerTerm WBT also provides a printing option where 

you can define print parameters, and print the terminal screen or data transferred 

from the host application. 

Step 4: Exit PowerTerm WBT 

Exiting PowerTerm WBT while it is connected to a host will end the connection. 

• Select File | Exit or press both <Alt> and <X> on the keyboard. 

If you have changed terminal settings, PowerTerm WBT displays a message 

asking if you want to update the terminal settings saved in the registry. The 

message will point to the name of the setup configuration currently loaded. 

Click OK to update the terminal settings, or No to cancel the latest changes 

and restore the default setup. 

If the session is still connected, PowerTerm WBT displays a message asking 

if you want to close the session. 
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2. PowerTerm WBT: General Reference 

2.1. The PowerTerm WBT Window 

 

The following is a list of the PowerTerm WBT window components as they appear 

from top to bottom. You can display or hide the components, except the Work area, 

as well as change colors and fonts, as will be convenient for you. 

 

Menu Bar Contains dropdown menus, which 

enable the user to perform most 

PowerTerm WBT operations. 

Toolbar Contains icons, which can be used as 

shortcuts to access frequently used 

menu commands. 

Work Area Displays the data entered on the 

device terminal or received from the 
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host. During an emulation session, this 

work area emulates a terminal display. 

For IBM terminal types, the 

background of the work area is by 

default displayed in black. 

History Scroll Bar For non-IBM emulations only. 

Enables you to scroll up and down 

through the PowerTerm WBT window 

to view previously displayed data. 

Default: Displayed. 

Soft Buttons Contains a series of buttons displayed 

above the Status bar that you can 

program to execute specific script 

commands. 

Status Bar Displays the emulation type, cursor 

position (row and column), text wrap 

and Caps lock status, as well as license 

information, Online/Offline status and 

communication LEDs. 

2.2. Menu Bar 

The PowerTerm WBT Menu bar displays the main PowerTerm WBT functions in 

dropdown menus. The following is a brief description of each menu and the 

functions that it can perform.  

2.2.1. File Menu 

The File menu provides options to create, save and restore a terminal setup file. 

You can also open keyboard settings and save them as well as open a new instance 

of the PowerTerm WBT window. 

Save Terminal Setup Saves the currently opened setup file. 

Both terminal setup and 

communication parameters are saved 

to the current setup.  

Save Terminal Setup As Opens the Save Terminal Setup As 

dialog, which enables you to save the 

current setup configuration under a 

name other than its current one. They 
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can also be saved to a specified file. 

Open Keyboard File Opens the Open Keyboard Setup dialog, 

which enables you to open keyboard 

mapping settings that have been 

previously saved in the registry or in a 

specified file. 

Save Keyboard file Opens the Save Keyboard Setup dialog, 

which enables you to save separate 

keyboard mapping settings in the 

registry and open them at a later date. 

They can also be saved to a specified 

file. 

Open Power Pad file Opens the Open Power Pad Setup 

dialog, which enables you to open 

Power Pad settings that have 

previously been saved in the registry 

or in a specified file. 

Save Power Pad File Opens the Save Power Pad Setup 

dialog, which enables you to save 

Power Pad settings in the registry and 

open them at a later date. They can 

also be saved to a specified file. 

Print Screen Prints the contents of the work area. 

Print Setup Displays the Print dialog, which 

contains modifiable printing 

parameters. 

Start/Stop Auto Print Prints all the data displayed in the 

work area. This option toggles between 

start and stop auto print. 

Close Print Queue Manually closes the print queue. 

Form Feed Executes a form feed on the printer. 

Line Feed Executes a line feed on the printer. 
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New Terminal Window Standard edition: Opens the Session 

Manager, which enables activating a 

pre-defined terminal session. 

Desktop edition: Opens the Connect 

dialog. 

Exit All Sessions Enables you to exit from all PowerTerm 

WBT sessions at once. 

Exit Enables you to exit from the current 

PowerTerm WBT session. 

2.2.2. Edit Menu 

The Edit menu provides options to select, clear, and reverse text in the PowerTerm 

WBT window and delete the contents of the history buffer. The Edit menu also 

provides standard editing commands such as cut/copy/paste, in addition to 

commands that enable you to copy data to a file and copy data automatically to the 

clipboard. 

Select Screen Selects the contents of the entire work 

area. 

Clear Screen Captures the entire PowerTerm WBT 

screen and passes the data to the 

history buffer. An example of an 

application that issues clear screen 

commands is VMS Mail. 

Clear History Deletes the entire contents of the 

history or scroll back buffer. This 

command is only available when the 

history buffer is in use. 

Reverse Screen For RTL languages only. 

Reverses the screen so that you can 

type from left to right or right to left, 

depending on the language you use. 

Cut For IBM emulations only. 

Cuts the selected text and places it on 
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the clipboard. 

Copy Use this Copy command to copy the 

marked text to the clipboard, if the 

Automatic Copy option in the Edit 

menu is not active.  

Paste Pastes the clipboard contents into the 

work area. Equivalent to actually 

typing the contents of the clipboard on 

the host screen. 

Automatic Copy Selected text from the work area is 

automatically copied to the clipboard. 

Copy Right to Left For RTL languages only. 

Reverses the order of the letters in the 

data that was copied to the clipboard, 

when displayed. 

2.2.3. Terminal Menu 

The Terminal menu provides options to define and reset connection parameters 

(terminal and communication), set the system to be online or offline, and freeze or 

unfreeze the screen. You can also select the fonts and languages (in versions that 

support it) to be displayed in the PowerTerm WBT window. 

Setup Opens the Terminal Setup dialog in 

which you can define settings for 

terminal emulation. This dialog 

contains different tab pages that 

enable you to define all aspects of your 

terminal setup. 

PowerTerm Fonts Displays the PowerTerm fonts in the 

PowerTerm WBT window. 

System Fonts Provides a selection of system fonts 

from which to choose. 

Reset Resets the VT terminal defaults. 
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Online Sets the system to be online or offline. 

Hold Screen Suspends and resumes communication 

with the host. Click the icon to toggle 

between hold and resume. 

English Alternatively, the language can be 

configured so that the user interface 

appears in German, French, Italian, 

Spanish, or Greek. 

2.2.4. Communication Menu 

The Communication menu provides security options as well as ability to set and 

clear Data Terminal Ready (DTR) and Ready to Send (RTS) signals and more. 

Connect 
For Desktop edition only. 

Displays the Connect dialog. 

Disconnect 
For Desktop edition only. 

Disconnects the current session. 

SSL Setup 
Displays the SSL Security Setup dialog in 

which you can define your security 

parameters. 

Utilities 
Displays signal options: 

• Dial, enables you to dial a 

specific phone number for COM 

type communication. 

• Break, sends a break for COM 

type communication. Equivalent 

to <Ctrl>+<Break>. 

• Set/Clear DTR, sets/clears DTR 

(Data Terminal Ready) signals. 

• Set/Clear RTS, sets/clears RTS 

(Ready To Send) signals. 

• AUX: Modify Connection, enables 

two-way slave printing to a serial 

printer. 
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2.2.5. Sessions Menu 

The Session menu lists all the active PowerTerm WBT sessions and enables you to 

toggle between them. The first session generated is automatically named Session 

A, the next Session B, and so on. 

2.2.6. Options Menu 

The Options menu provides various alternatives to customize your PowerTerm WBT 

screen. It also enables you to display and edit the Power Pad and how to map your 

keyboard, as well as create trace logs. 

 Press <Ctrl>+<Shift>+M on the keyboard to display a floating menu which 

offers to show/hide menu, buttons, status bar, and Power Pad. 

Keyboard Map Displays the Keyboard Mapping dialog, 

which enables you to map your 

POWERTERM WBT keys to host keys 

on the terminal keyboard. 

Power Pad Setup Displays the Power Pad Setup dialog, 

which enables you to adjust the 

number of buttons contained in the 

Power Pad by specifying the number of 

rows and columns to be displayed. 

Start/Stop Trace Stores received data in the Trace.log 

and Capture.log files. These files are 

located in the working directory. The 

menu command toggles between Start 

Trace and Stop Trace. 

• Capture.log stores raw data, as 

received from the host. 

• Trace.log stores formatted data 

with readable escape 

sequences.  

Input Trace Runs the contents of the Capture.log 

file, as if it were received from the 

host. 

Hide Menu Hides the Menu bar. 

To restore the Menu bar press 

<Ctrl>+<Shift>+<M>. 
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Hide/Show Buttons The menu command toggles between 

Hide and Show Buttons. 

Hide/Show Status Bar The menu command toggles between 

Hide and Show Status Bar. 

Hide/Show Power Pad The menu command toggles between 

Hide and Show Power Pad.  

2.2.7. Script Menu 

The Script menu provides options to record, edit, and run PSL scripts. 

Run Script Displays the Run Script dialog, which 

enables you to select and run a script. 

Edit Script Displays the Edit Script dialog, which 

enables you to select the script that 

you want to edit or to create a new 

one. 

Script Command Displays the Script Command dialog, 

which enables you to run individual 

script commands. 

Start/Stop Script Recording Records a script automatically. After 

requesting Start Script Recording, the 

manual operations you perform in the 

emulation screen are recorded into a 

script file until you choose the Pause or 

Stop Script Recording command. 

Pause/Continue Script Recording Pauses or resumes the script 

recording. 

Activate Recorded Script Activates the script currently recorded 

in memory. The script is saved in 

memory while PowerTerm WBT session 

is active until it is saved to the registry 

with a specific name. 

Save Recorded Script Enables you to save a script from 

memory to the registry with a specific 
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name. 

2.2.8. Help Menu 

The Help menu provides options for accessing the product and perform license 

management. 

About PowerTerm WBT Displays product and contact 

information. 

2.3. Toolbar 

The PowerTerm WBT Toolbar contains icons, which provide shortcuts to frequently 

used menu options. The following is a brief description of the icons. You can also 

place the cursor over the icon to display its description as a tool tip. 

 Some emulation types display only part of the icons.  

Hold Screen/Release Hold  
 

For non-IBM emulations only. 

Suspends and resumes 

communication with the host.  

Equivalent to Terminal | Hold Screen. 

Cut  
 

For IBM emulations only. 

Cuts the selected text. 

Equivalent to Edit | Cut. 

Copy to Clipboard  
 

Copies the selected data displayed 

in the work area to the clipboard. 

Equivalent to Edit | Copy. 

Paste from Clipboard 
 

Pastes data from the clipboard to 

the host application. 

Equivalent to Edit | Paste. 

Print 
 

Prints selected text from the history 

buffer or the entire contents of the 

work area. 
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Equivalent to File | Print Screen. 

Start/Stop Auto Print 
 

For non-IBM emulations only. 

Prints incoming data as it is 

displayed on the screen. Click the 

icon again and the automatic 

printing stops. 

Equivalent to File | Start Auto Print. 

Start/Stop Script Recording 
 

Records manual operations in script 

form. Click the icon again and the 

script recording stops. 

Equivalent to Script | Start Script 

Recording. 

Change to 80 Columns 
 

For non-IBM emulations only. 

Specifies an 80-column display for 

the work area. 

Equivalent to Terminal | Setup | 

Display. 

Change to 132 Columns 
 

For non-IBM emulations only. 

Specifies a 132-column display for 

the work area. 

Equivalent to Terminal | Setup | 

Display. 

Terminal Setup 
 

Displays the Terminal Setup dialog in 

which you can define terminal setup 

parameters. 

Equivalent to Terminal | Setup. 

Keyboard Mapping 
 

Opens the Keyboard Mapping dialog 

in which you can map PowerTerm 

WBT keys to host keys. 



 

PowerTerm WBT  User’s Manual 19 

Show/Hide Power Pad 
 

Displays the Power Pad. Click the 

icon again and the Power Pad 

closes. 

Equivalent to Options | Show Power 

Pad. 

Help Contents 
 

Displays product information. 

Equivalent to Help | About 

PowerTerm WBT. 

Standard edition: Activate 

Defined Connection 

Desktop edition: New Terminal 

Window 

 
Opens the Session Manager dialog. 

Equivalent to File | New Terminal 

Window. 

Session 
 

Provides an icon with an identifiable 

letter for each additional session of 

PowerTerm WBT. 

Equivalent to pressing 

<Ctrl>+<Shift>+the desired session's 

letter on the keyboard. 

2.4. Hot Keys 

Hot keys are keyboard shortcuts that you can use instead of choosing menu 

commands. These hot keys refer to your standard PowerTerm WBT keyboard keys, 

before they are mapped to terminal keys. Once hot keys are mapped, they lose 

their original function and reflect the newly mapped terminal key. For example, if 

you map <Alt F4> to the <Backspace> key on the terminal keyboard, it performs 

the function of a <Backspace> key. 

The following table lists the default PowerTerm WBT hot keys: 

Alt F4 Exit 

Alt F9 Activate script 

Ctrl+Shift+R Start/Stop script recording 

Ctrl+Shift+P Activate recorded script 
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Alt F10 Select screen 

Alt F11 Clear screen 

Alt F12 Reverse screen  

IBM 5250 emulations not included. 

Scroll Lock Hold screen 

Pause Change the cursor shape 

Ctrl Up Arrow Scroll up one line 

Ctrl Down Arrow Scroll down one line 

Ctrl Home Scroll to the beginning of the history 

buffer 

Ctrl End Scroll to the end of the history buffer 

Ctrl Page Up Scroll up one page 

Ctrl Page Down Scroll down one page 

2.5. Dialog Boxes 

 The parameter options change according to emulation and Session Type 

(protocol) selected.  

The different parameter options are described in detail on the following pages 

(some emulation types have identical parameters). 

Session Types 

TELNET Uses the Telnet protocol over TCP/IP 

for network communication. 

COM Uses serial communication with the 

device's COM ports. 
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TN3270 TELNET for IBM 3270 emulations. 

TN5250 TELNET for IBM 5250 emulations. 

NSVT For HP emulations only. 

2.5.1. Connection Properties 

Telnet Protocol, Non-IBM Emulations 

 

 

Host Name Specifies the host computer name or 

the host's IP address. 

Terminal ID Enables you to change the ID returned 

by the emulation program to the host. 
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Terminal Specifies the terminal name. 

Port # Specifies the port number. 

Emulation Type Enables you to change the currently 

supported emulation. 

Language Specifies the language to be used in 

the graphical user interface. 

Terminal Setup, specifies the emulation 

parameters. 

GUI, specifies what work area 

components will be displayed or 

hidden. 

Keyboard, enables you to map the 

keyboard. 

Security Specifies whether or not to employ a 

security protocol, and what kind. 

Use Terminal Configuration Specifies the terminal setup file to be 

used in the connection. You can 

browse for the file if necessary. 

Run Script On Logon Specifies the script to be run on logon. 

You can browse for the file if 

necessary. 

Connection Name Specifies the name of the connection, 

which is displayed both in the 

Connection Manager and Session 

Manager. 

Wait Before Connect (Sec) Specifies how long to wait before 

connecting to the host. 

About Displays PowerTerm WBT copyright 

and version number information. 
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COM Protocol, Non-IBM Emulations 

 

 

Terminal ID Enables you to change the ID returned 

by the emulation program to the host. 

Properties Specifies COM properties such as port, 

baud rate etc. 

Emulation Type Enables you to change the currently 

supported emulation. 

Language Specifies the language to be used in 

the graphical user interface. 
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Terminal Setup, specifies the emulation 

parameters. 

GUI, specifies what work area 

components will be displayed or 

hidden. 

Keyboard, enables you to map the 

keyboard. 

Use Terminal Configuration Specifies the terminal setup file to be 

used in the connection. You can 

browse for the file if necessary. 

Run Script On Logon Specifies the script to be run on logon. 

You can browse for the file if 

necessary. 

Connection Name Specifies the name of the connection, 

which is displayed both in the 

Connection Manager and Session 

Manager. 

Wait Before Connect (Sec) Specifies how long to wait before 

connecting to the host. 

About Displays PowerTerm WBT copyright 

and version number information. 



 

PowerTerm WBT  User’s Manual 25 

Telnet Protocol, 3270 Display Emulation 

 

 

Host Name Specifies the host computer name or 

the host's IP address. 

Terminal ID Enables you to change the ID returned 

by the emulation program to the host. 

LU Name In this parameter you can specify the 

LU name (maximum: 10 characters). 

Port # Specifies the port number. 

Use TN3270E Protocol Select this option if you want to work 

with TELNET SNA extensions. 
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Emulation Type Enables you to change the currently 

supported emulation. 

Language Specifies the language to be used in 

the graphical user interface. 

Security Specifies whether or not to employ a 

security protocol, and what kind. 

Terminal Setup, specifies the emulation 

parameters. 

GUI, specifies what work area 

components will be displayed or 

hidden. 

Keyboard, enables you to map the 

keyboard. 

Use Terminal Configuration Specifies the terminal setup file to be 

used in the connection. You can 

browse for the file if necessary. 

Run Script On Logon Specifies the script to be run on logon. 

You can browse for the file if 

necessary. 

Connection Name Specifies the name of the connection, 

which is displayed both in the 

Connection Manager and Session 

Manager. 

Wait Before Connect (Sec) Specifies how long to wait before 

connecting to the host. 

About Displays PowerTerm WBT copyright 

and version number information. 
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Telnet Protocol, 3270 Printer emulation 

 

 

Host Name Specifies the host computer name or 

the host's IP address. 

Terminal ID Enables you to change the ID returned 

by the emulation program to the host. 

LU Name In this parameter you can specify the 

LU name (maximum: 10 characters). 

Port # Specifies the port number. 

Use TN3270E Protocol Select this option if you want to work 

with TELNET SNA extensions. 



 

PowerTerm WBT  User’s Manual 28 

Associated LU Implements the TN3270E ASSOCIATE 

command, when checked. The 

requested LU is the LU of the 

associated DISPLAY session. That is, 

the MF will return the printer LU that is 

associated to that display (by the MF 

administrator). 

Emulation Type Enables you to change the currently 

supported emulation. 

Security Specifies whether or not to employ a 

security protocol, and what kind. 

Terminal Setup, specifies the emulation 

parameters. 

GUI, specifies what work area 

components will be displayed or 

hidden. 

Keyboard, enables you to map the 

keyboard. 

Use Terminal Configuration Specifies the terminal setup file to be 

used in the connection. You can 

browse for the file if necessary. 

Run Script On Logon Specifies the script to be run on logon. 

You can browse for the file if 

necessary. 

Connection Name Specifies the name of the connection, 

which is displayed both in the 

Connection Manager and Session 

Manager. 

Wait Before Connect (Sec) Specifies how long to wait before 

connecting to the host. 

About Displays PowerTerm WBT copyright 

and version number information. 
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Telnet Protocol, 5250 Display Emulation 

 

 

Host Name Specifies the host computer name or 

the host's IP address. 

Terminal ID Enables you to change the ID returned 

by the emulation program to the host. 

Device Name Enables you to enter the device name 

for the emulation session (maximum: 

10 characters).  

Port # Specifies the port number. 

Emulation Type Enables you to change the currently 

supported emulation. 
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Language Specifies the language to be used in 

the graphical user interface. 

Security Specifies whether or not to employ a 

security protocol, and what kind. 

Terminal Setup, specifies the emulation 

parameters. 

GUI, specifies what work area 

components will be displayed or 

hidden. 

Keyboard, enables you to map the 

keyboard. 

Use Terminal Configuration Specifies the terminal setup file to be 

used in the connection. You can 

browse for the file if necessary. 

Run Script On Logon Specifies the script to be run on logon. 

You can browse for the file if 

necessary. 

Connection Name Specifies the name of the connection, 

which is displayed both in the 

Connection Manager and Session 

Manager. 

Wait Before Connect (Sec) Specifies how long to wait before 

connecting to the host. 

About Displays PowerTerm WBT copyright 

and version number information. 
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Telnet Protocol, 5250 Printer Emulation 

 

 

Host Name Specifies the host computer name or 

the host's IP address. 

Terminal ID Enables you to change the ID returned 

by the emulation program to the host. 

Device Name Enables you to enter the device name 

for the emulation session (maximum 

10 characters).  

Port # Specifies the port number. 

Message Queue Designates to which AS/400 the 

message queue exception messages 
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should be sent. 

Message Library Specifies which library contains the 

message queue for exception 

messages. 

Emulation Type Enables you to change the currently 

supported emulation. 

Language Specifies the language to be used in 

the graphical user interface. 

Security Specifies whether or not to employ a 

security protocol, and what kind. 

Terminal Setup, specifies the emulation 

parameters. 

GUI, specifies what work area 

components will be displayed or 

hidden. 

Keyboard, enables you to map the 

keyboard. 

Use Terminal Configuration Specifies the terminal setup file to be 

used in the connection. You can 

browse for the file if necessary. 

Run Script On Logon Specifies the script to be run on logon. 

You can browse for the file if 

necessary. 

Connection Name Specifies the name of the connection, 

which is displayed both in the 

Connection Manager and Session 

Manager. 

Wait Before Connect (Sec) Specifies how long to wait before 

connecting to the host. 

About Displays PowerTerm WBT copyright 

and version number information. 
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2.5.2. Emulation Property Page 

For Desktop edition only. 

 

The Emulation property page displays the supported terminal emulations and 

enables you to select a terminal type. The emulation type that you select changes 

the tabs (property pages) displayed and their options. 
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2.5.3. General Property Page 

Non-IBM Emulations 

 

 

Terminal ID Determines the ID returned by the 

emulation program to the host. Verify 

that you select an ID that the host 

application/system recognizes. NOTE 

that once connection has been 

initiated, the ID combo box becomes 

disabled. 

NRC Set Determines the communication and 

keyboard character set for 7-bit data 

only.  

UPS Set Determines the communication and 

keyboard character set for 8-bit data 

only. 

8 bit Controls Enables when UPS Set is specified as 

Code Page 437 and up.  

Disable, determines if 0x80 to 0xAF are 

displayed characters. 
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Enable, determines if 0x80 to 0xAD are 

control characters. 

0x9B, all characters are displayed 

characters except 0x9B, which is a 

control character. 

Online Equivalent to Terminal | On Line (Off 

Line). 

New Line Determines whether the <Enter> key 

generates only a carriage return or a 

carriage return/line feed combination. 

Use 8 Bit Data Characters Select this parameter if the 

communicated data is in 8-bit 

character format. Clear it for 7-bit 

characters. When cleared, the 8th bit is 

truncated. If you receive 7-bit data, 

you can convert it to 8-bit data for 

printing on the slave printer. 

User Defined Keys (UDK) Determines whether applications on 

the host system can override your 

user-defined keys (UDKs) when you 

have defined a function key that 

conflicts with how the host wants to 

use this key. 

Locked, prevents UDKs from being 

overridden. 

Unlocked, allows UDKs to be 

overridden. 

Cursor Keys Determines the behavior of the four 

arrow keys. 

Normal, generates ANSI-standard 

control sequences for moving the 

cursor. 

Application, generates customized 

application program functions. 
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Keypad For VT emulations only. 

Determines the effects of the numeric 

keypad on your keyboard. 

Numeric, keypad keys insert numbers. 

For example, pressing <7> on the 

numeric keyboard is the same as 

typing '7' on the keyboard. 

Application, keypad keys generate 

control sequences that can be used by 

some applications. 

(Use) NumLock, enables or disables the 

NumLock keyboard function in respect 

to the above Numeric and Application 

modes: 

"NumLock" checkbox not checked, the 

NumLock key is a regular emulation 

key that has been mapped/defined as 

PF1 (default) or any other key. The 

NumLock key will not change the 

NumLock keyboard status. 

"NumLock" checkbox checked: 

Numeric Keypad Mode, the NumLock 

key toggles between function states: 

enabling numeric keys (when lit) or 

arrow keys (when not lit). 

Application Keypad Mode, the NumLock 

key toggles between function states. 

Enabling numeric keys (when lit) or 

application keys (when not lit). 

Cursor coupling Vertical, determines whether the user 

window pans with the cursor when the 

cursor moves past the top or bottom 

border of the user window. 

Page, determines if a new page 

appears in the display when the cursor 

moves to a new page. 

Status Line None, displays an emulation screen 

without the status line. 
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Indicator, displays the status line. 

Host Writeable, disaplays the status 

line sent by the host. 

Label Line, displays a status line on the 

top and bottom line of the emulation 

screen. 

Label Line 
For ASCII emulations only. 

Displays a status line on the top and 

bottom line of the emulation screen. 

IBM Emulations 

 

 

General ID, determines the ID returned by the 

emulation program to the host. Make 

sure you select an ID that the host 

application recognizes. NOTE that once 

connection has been initiated, the ID 

combo box becomes disabled. 

Unscaled Screen, when this parameter 

is cleared, the characters appearing in 

the work area are scaled. A change in 

the size of the desktop causes the 
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fonts to shrink in relation to the size of 

the window. Select this parameter if 

you want to disable this feature. 

Show Respone Time, displays the 

number of seconds that elapsed 

between the time data was sent to the 

host and the host response time. 

Cursor Ruler Select Visible to display full-screen, 

vertical or horizontal lines as a cursor 

ruler (cross hair guide). 

Cross Hair, displays the cursor ruler as 

a horizontal and vertical line. 

Horizontal, displays the cursor ruler as 

a horizontal line only. 

Vertical, displays the cursor ruler as a 

vertical line only. 

Cursor Controls the cursor appearance and 

functionality: 

Block/Underline/Visible/Blink, controls 

the cursor appearance. 

Ins Change, when selected it enables 

toggling the cursor between underline 

and block appearance, by clicking the 

Ins (insert) button. 

Appearance Power GUI, displays data in a window 

with 3D look & feel. Use system fonts 

larger than 10 pt. for optimized 

results. 

Show Frame, places a frame around the 

text area of the emulation. 

HLLAPI Names The names of an hllapi session can 

either be short or long. 

Short and Long, enables you to specify 

the short and long hllapi names. 
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Code Page Specifies the host and PowerTerm WBT 

(keyboard) character sets. 

Alternate Size Enable, select to override the terminal 

alternate size with a specific size. 

Rows/Columns, type the required 

number. 

2.5.4. Display Property Page 

For non-IBM emulations only. 

 

 

General Reverse Display Colors, reverse the text 

and background colors in the work 

area. 

Unscaled Screen, when this parameter 

is cleared the characters appearing in 

the work are scaled. A change in the 

size of the desktop causes the fonts to 

shrink in elation to the size of the 

window. Select this parameter if you 

want to disable this feature. 

Autowrap Characters, wraps words at 
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the end of a line and the cursor moves 

to the next line. 

History Scroll Bar, displays the vertical 

history scroll bar along the right edge 

of the PowerTerm WBT screen. This 

enables you to scroll through the data 

displayed previously on the screen. If 

the host transmits during scrolling, the 

display automatically scrolls back to its 

current position. NOTE Selecting Clear 

History from the Edit menu can erase 

the History buffer. 

Cursor Ruler Select Visible to display full-screen, 

vertical or horizontal lines as a cursor 

ruler (cross hair guide). 

Cross Hair, displays the cursor ruler as 

a horizontal and vertical line. 

Horizontal, displays the cursor rules as 

a horizontal line only. Vertical, displays 

the cursor ruler as a vertical line only. 

Vertical, displays the cursor ruler as a 

vertical line only. 

Cursor Controls the cursor appearance and 

functionality: 

Block/Underline/Visible/Blink, controls 

the cursor appearance. 

Ctrl Characters Display, displays the control 

characters. 

Interpret, displays normal text as 

affected by control characters. 

Power GUI Displays data in a window with 3D look 

& feel. Use System fonts larger than 

10 pt for optimized results. 

Show Frame Places a frame around the text area of 

the emulation. 
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Dimensions Determines the number of characters 

(columns) per displayed line, and the 

number of lines to be displayed in the 

work area. Characters are scaled 

according to the selected values. Type 

a different value in the Other box 

instead of choosing one of the 

standard options (80 and 132). 

Limit Font Size, allows PowerTerm fonts 

to use only the optimal font size, 

especially for frames. NOTE It is not 

recommended for normal text on large 

screens. 

Scrolling Determines the pace at which data is 

displayed in the work area as it 

arrives. If you select Jump, you should 

determine the Jump Scroll Speed that 

is measured in number of line units. 

The higher the value, the faster the 

scrolling. 

Unlimited, displays data without 

delaying communication. 

Page, scrolls data by full screens. 

Smooth, is equivalent to a Jump Scroll 

Speed of 1. 

Enable Soft fonts Enables you to work with VT soft fonts. 

The fonts will be loaded from the host 

application. 
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2.5.5. Keyboard Property Page 

Non-IBM Emulations 

 

 

Capslock Mode Determines the behavior of the Caps 

Lock key. 

Caps (Unix), locks alphabet keys on 

main keypad in uppercase. 

Shift, locks alphabet and numeric keys 

on main keypad in shift setting. 

Pressing the shift button on your 

keyboard will release shift-lock mode. 

Reverse (Win), Same behavior as Caps 

Lock, however pressing the shift 

button on your keyboard reverses the 

caps operation. 

Always On, enables you to toggle to a 

different application and turn Caps 

Lock mode off. On return to 

PowerTerm it will automatically revert 

to Caps Lock on. 

Backspace Key Sends Determines whether the <Backspace> 

key sends Delete or an actual 
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Backspace. 

Auto Repeat Repeatedly displays the character 

whose key is being continuously 

pressed down. 

Key Click Issues a click sound when you press a 

key on the keyboard. 

Warning Bell Determines whether the terminal 

sounds a bell tone when receiving the 

"bell" (ASCII 7) character. For 

operating errors, mail messages, etc. 

Margin Bell Determines whether the terminal 

sounds a bell tone when the cursor 

reaches the right margin. 

Numpad Decimal sends Comma Specifies that the Numeric Pad's 

decimal key sends a comma instead of 

a decimal. 

Use Emulator Alt Keys Select to make an <Alt> key perform 

the terminal operation even if Windows 

OS has an operation mapped to the 

same key. 

Local Echo Determines whether keyboard input is 

displayed (echoed) on your screen. 

Select, to display the keyboard input 

even if the host system does not echo 

your input. 

Clear, to send the keyboard input to 

the host system without being 

displayed on the screen (unless the 

host system echoes the characters). 

Use VT Keyboard Mode Changes your keyboard into a Digital 

VT keyboard mode. In this mode, the 

PowerTerm WBT keyboard operates as 

close to a VT keyboard as possible, 

and takes full advantage of LK450 
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Digital keyboards. 

Answerback Message Specifies an answerback message and 

its display. 

Clear, deletes the message. 

Conceal, hides the message without 

being deleted. 

Auto Answerback Determines whether the terminal 

automatically sends the message to 

the host system after you make the 

connection. This is useful if your 

answerback message is a command to 

the host system. 

IBM 3270 Emulations 

 

 

Backspace Deletes Select to delete characters by pressing 

the Backspace key. 

Auto Repeat Repeatedly displays the character for 

which its key is being continuously 

pressed down. 
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Key Click Issue a click sound when you press a 

key on the keyboard. 

Lock Numeric Field Determines whether the keyboard is 

locked when you try to enter non-

numeric data. 

Select, non-numeric data cannot be 

typed in the field. 

Select and grayed, non-numeric data 

can be typed in the field only if 

<Shift> is pressed. 

Cleared, non-numeric data (i.e. any 

data) can be typed in the field. 

Typeahead Types data ahead, before the host 

responds. 

Automatic reset Key If the Keyboard is locked, a reset key 

sequence is generated prior to when 

you click on the tab key to advance to 

the next field. 

Numpad Decimal Sends Comma Determines whether the Numeric Pad 

sends a comma instead of a decimal. 

Use Emulator Alt Keys Select to make an <Alt> key perform 

the terminal operation even if Windows 

OS has an operation mapped to the 

same key. 

Non SNA System Wait Determines whether the System Wait 

in the IBM 3270 emulation will act as a 

System Wait in a non-SNA terminal. 
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IBM 5250 Emulations 

 

Backspace Deletes Select to delete characters by pressing 

the Backspace key. 

Auto Repeat Repeatedly displays the character for 

which its key is being continuously 

pressed down. 

Key Click Issue a click sound when you press a 

key on the keyboard. 

Warning Bell Determines whether the terminal 

sounds a bell tone when receiving the 

"bell" (ASCII 7) character. For 

operating errors, mail messages, etc. 

Typeahead Types data ahead, before the host 

responds. 

Automatic reset Key If the Keyboard is locked, a reset key 

sequence is generated prior to when 

you click on the tab key to advance to 

the next field. 
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Numpad Decimal Sends Comma Determines whether the Numeric Pad 

sends a comma instead of a decimal. 

Use Emulator Alt Keys Disables the standard Windows Alt 

sequences, such as Alt+<F4>. When 

this option is selected, an Alt sequence 

will perform the operation assigned to 

it by the emulated environment. 

2.5.6. Printer Property Page 

 

 

Print Device Allows you to select a printing output 

channel. 

None, no destination was assigned. 

The Device Name is disabled. Printer 

data is received by the terminal, but 

discarded (not printed). 

Serial, sends printing according to the 

serial port parameters specified. 

Parallell, sends printing through the 

specified port. 

Network, sends printing to the network 
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printer. You must hen perform the 

following: 

1. Select File | Print Setup. 

2. Select Network from Port field. 

3. Type UNC (Universal Naming 

Convention) in the Net Path. For 

example, \\net1\hp4000 

LPR, redirects printing to the LPD 

server according to the specified 

parameters. 

USB, prints to a printer that is 

connected to one of the USB 

connectors in the WBT device. 

File, sends printing to the file specified 

in the File Name text field. 

AUX, sends printing to the auxiliary 

port. 

Device Name The available printing devices are: 

LPT1: (default) COM x: 

Use Form Feed Adds a form feed (page eject) after 

each printing job. This depends upon 

the available connections on your 

device. 

Print Line Graphics As Text Converts line graphics to text. This 

speeds up printing on a slow dot-

matrix printer. 

LF->CRLF Adds a line feed after each single 

carriage return (one that has no line 

feed following it) when in slave 

printing mode. 

Print Screen Data Conversion Converts data to Host or UTF-8 

character sets, or print in Graphics 

mode. 

None, does not convert data. 
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Slave Printer Data Conversion Converts data to Host or UTF-8 

character sets, or prints in Graphics 

mode for slave printing. 

None, does not convert data. 

Slave Printer Job Delimiter For non-IBM emulations only. 

Specifies the job delimiter character 

that will divide the data into print jobs, 

thus disabling the escape sequences 

arriving from the host application. 

Delay for Print Closing The command to close the printer 

queue is delayed by the number of 

seconds that you determine. This 

command only takes effect if no open 

command is issued in the meantime. 

Important for printing to cut sheet 

printers (for example, inkjets/lasers) 

and network printers. 
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2.5.7. Advanced Printing Setup 

 

 

Printer Type Specifies the destination printer. 

Edit enables you to edit the printer 

configuration file. 

Margins Specifies the space between the edge 

of the printout page and the border of 

the printing. 

Font Printer default font and size will be 

applied to the output when Ignore is 

selected. Otherwise, User input will be 

applied. Select the desired font from 

the Font dropdown list. 



 

PowerTerm WBT  User’s Manual 51 

CPI Character per Inch 

LPI Lines per Inch 

Printer Columns/Rows For graphic printing only. 

Determines the number of printer 

columns/rows in the output. Select 

Ignore to apply the number of columns 

on your emulation screen to the 

output. 

Page Type for Text Printing Specifies the page type (for example, 

A3, A4, A5 etc.) 

Form Feed Defines the form type of the printer. 

PowerTerm provides the following 

three types: 

AUTOCUT, single-cut sheets are 

automatically fed into the printer. Most 

printers require a sheet feed 

attachment. 

CONT, continuous sheets are used by 

printers that have a tractor feed 

attachment on the device. 

CUT, single-cut sheets are manually 

fed into the printer. 

Orientation Specifies the orientation of the printed 

output. The default depends on your 

printer' settings. 

Enable AS/400 Host Print Transform Enabled, pass through (transparent) 

mode. The host sends (ASCII) 

command and text directly to the 

printer. Non-graphic printing only. 

Disabled, the host sends (EBCDIC) 

5250 SCS format commands and text 

to the emulation. The emulation, in 

turn, translates to printer specific 
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commands. 

Customizing Object Specifies the object name that you 

have previously defined on the 

AS/400. Enabled only for "Other" 

printer models. 

Library Specifies the customizing object's 

library on the AS/400. Enabled only for 

"Other" printer models. 

Drawer 1 Specifies the size for the paper in 

Paper Source 1. 

Drawer 2 Specifies the size for the paper in 

Paper Source 2. 

Envelope Hopper Specifies the size of the envelope. 

Supports ASCII Code-Page 899 Specifies whether the printer has Code 

Page 899 installed. 

2.5.8. Tabs Property Page 

For VT emulations only. 
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Tabs Stops Click anywhere within the Tab Stops 

area to set tab stops manually. 

Set Every, sets a tab stop in 

increments of a number typed in the 

adjacent text field. 

Clear All, clears all tab stops. 

2.5.9. Colors Property Page 

Non-IBM Emulations 

 

 

Preview Box Shows the result of your selections. 

Enable Underline Enables underlined characters. Clear to 

disable displaying data with the 

underline, for data transmitted from 

the host with the Underline attribute. 

Enable Blink Enables blinking. Clear to disable 

blinking data, for data transmitted 

from the host with the blink attribute. 
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Coloring method For selecting the coloring method: 

Default Colors, (recommended) uses 

the default color settings for each 

emulation type:  

VT and Siemens – Attribute & ANSI 

colors. 

ANSI and HP – ANSI colors. 

All others – Attribute colors (i.e. not 

affected by setting to a different 

value). 

Attribute, colors based on the 

attributes bold/underline/reverse/blink 

etc. Changing these settings will 

change the display accordingly. 

ANSI, colors based on host-defined 

colors. For example, the host sends 

"red foreground on blue background" 

however you can select the default 

ANSI color. Different attributes do not 

affect colors. 

Attribute & ANSI, the text displayed is 

affected by changing 

the color settings corresponding to 

either the desired color or attribute. 

For example, when the Host sends text 

as: "Red and Bold", the color 

specified by the Host is applied first, 

and the attribute specified 

second; If no color is specified, then 

the text will be displayed 

based on the "Bold" attribute setting 

only. 

ANSI 8 color mode A regular terminal has 16 colors (8 

colors with the Bold attribute applied 

to them and 8 colors without the Bold 

attribute applied to them). The 

Background color never has the bold 

attribute (therefore it is "dark") while 

the Text (foreground) is always 

mapped to the color with the Bold 

(bright, light) attribute. 
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Non-selected, each entity (text, 

background) can have any of the 16 

colors mapped to them. 

Selected, each entity (text, 

background) can have any of the 8 

colors mapped to them. 

Color Frame Select to draw a color frame on the 

screen. 

Select Attribute Select the attribute for which you want 

to define foreground and background 

colors. Attributes change according to 

the emulation type you selected in the 

Connection properties dialog. 

Generally, the attribute of the entire 

screen is Normal. The color for the 

Normal attribute determines the color 

of the entire work area. 

Text Select the color that will apply to the 

text (foreground) of the display. 

Background Select the color that will apply to the 

background of the text. 
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IBM Emulations 

 

 

Preview Box Shows the result of your selections. 

Enable Underline Enables underlined characters. Clear to 

disable displaying data with the 

underline, for data transmitted from 

the host with the Underline attribute. 

Enable Blink Enables blinking. Clear to disable 

blinking data, for data transmitted 

from the host with the blink attribute. 

Column Separator Displays a period as a column 

separator in fields with the column 

separator attribute. 

Color Frame Select to draw a color frame on the 

screen. 

Select Attribute Select the attribute for which you want 

to define foreground and background 

colors. Attributes change according to 

the emulation type you selected in the 

Connection properties dialog. 
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Generally, the attribute of the entire 

screen is Normal. The color for the 

Normal attribute determines the color 

of the entire work area. 

Text Select the color that will apply to the 

text (foreground) of the display. 

Background Select the color that will apply to the 

background of the text. 

2.5.10. Preferences Property Page 

 

 

History Buffer Specifies the size of the buffer in which 

data is stored, by selecting an option 

from the dropdown list. 

On PowerTerm Exit Save Terminal Setup, the new terminal 

parameters (if you changed them 

during the session) are saved to the 

current terminal setup file. 

Confirm Save, terminal parameters are 

not saved automatically. PowerTerm 

WBT displays a dialog where you can 
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decide whether or not to save any 

changes you did to the settings during 

the session. 

Confirm Disconnect Session, if you 

close PowerTerm WBT during a 

session, you will be required to confirm 

disconnect. 

Inactivity Timeout, specifies the time 

limit for keyboard inactivity, after 

which PowerTerm WBT shuts down. 

On Session Exit Auto Reconnect, re-establishes 

communication if the line was 

disconnected. 

Auto Exit PowerTerm, closes 

PowerTerm WBT altogether on 

disconnect. 

2.5.11. SSL Security 

In the SSL Security Setup dialog you specify your SSL security behavior. You may 

select to accept only certificates that exist in the certificates path or any incoming 

certificate. You can also specify if you want to display unknown certificates at 

connection time and whether you want to save them. 



 

PowerTerm WBT  User’s Manual 59 

 

2.5.12. SSH Security Settings 
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SSH Version Specifies which version of SSH is 

employed. 

Show SSH Login Dialog on Connection Displays the SSH Login dialog upon 

connection. 

Show SSH Info Displays the SSH information after the 

host connection is established. 

User Name Specifies the User Name. 

Cipher Specifies the cipher algorithm to be 

used to encrypt network traffic 

between the local machine and the 

server, thus providing data privacy. 

Available cipher algorithms are: 

BLOWFISH, 3DES, DES and AES. 

Enable Compression Select to employ compression. 

Enable x11 Forwarding Select to allow X Windows traffic 

between the X server and X client to 

be encrypted. 

Attempt TIS or CryptoCard Authentication Select to authenticate with either TIS 

or CryptoCard. 

Attempt 'keyboard – ineteractive' Auth 

(SSH2) 

Select to authenticate with 'keyboard – 

interactive'. 

Allow Agent Forwarding Passes authorization information over 

the encrypted link. 

Private Key File for Authentication Specifies the private key file for public 

key authentication. 
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2.5.13. GUI Settings 

 

 

Hide PowerTerm window 

components 

Specifies which window components to 

hide. 

Hide SubMenus 
Specifies which submenus to hide. 



 

PowerTerm WBT  User’s Manual 62 

3. Starting and Stopping Sessions 

You can determine PowerTerm WBT behavior and automate processes in the 

Preferences property page. These remain active until you change them. For 

example, if you select to connect automatically at PowerTerm WBT startup, you will 

always be connected when you open PowerTerm WBT. Other behaviors you can 

customize are for example auto-reconnect and keyboard inactivity time limit. 

 To define preferences: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. The Preferences property page is displayed. 

3. Select the parameters that you require. 

 To confirm disconnect: 

Require a confirmation when closing PowerTerm WBT during a session. 

In the Preferences tab, select Confirm Disconnect Session.  

 To specify keyboard inactivity timeout: 

Specify the time limit for keyboard inactivity, after which PowerTerm WBT shuts 

down. 

In the Preferences tab, enter the amount of minutes for Inactivity Timeout. 

 To specify reconnect mode: 

Re-establish communication if the line was disconnected. 

In the Preferences tab, select Auto ReConnect. 

 To automatically exit PowerTerm WBT: 

Close PowerTerm WBT altogether on disconnect. 

In the Preferences tab, select Auto Exit PowerTerm. 
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4. Defining Emulations 

The General property page enables you to define parameters for the selected 

emulation type, such as: 

• The ID returned by the emulation program to the host. 

 Once connection has been initiated, the ID combo box becomes 

disabled. 

• Communication and keyboard character sets for both 7-bit and 8-bit data. 

• The behavior of the <Enter> key. 

• Whether applications on the host system can override your user-defined 

keys (UDKs) 

• VT emulations only. Determines the effects of the numeric keypad on your 

keyboard 

• Cursor coupling 

• Status Line 

 To define emulation parameters: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the General tab. The General property page is displayed. 

3. Select the parameters that you require. 

General parameters 

 To define host's ID response: 

In the General tab, select Terminal ID from the dropdown list. 

 To specify type of Cursor coupling: 

In the General tab, select Vertical to move the cursor past the top or bottom border 

of the user window, or Page to move the cursor to a new page. 

Non-IBM specific parameters 

 To define communication and keyboard character set: 

In the General tab, select the NRC/UPS set required from the dropdown list. 

 To set the terminal to be online/offline: 

In the General tab, select or clear Online. 

 To define the Enter key behavior: 

In the General tab, select New Line. 
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 To define the window pane: 

In the General tab, specify if you want Vertical or Page display. 

 To define user-defined key behavior: 

In the General tab, select or clear User Defined Keys Locked. 

 To show a status line: 

Specify if you want your session's or the host's status line. 

In the General tab, select Indicator or Host Writable. 

IBM specific parameters 

 To define scaled/unscaled screen: 

In the General tab, select or clear Unscaled Screen.  

 To display host response time: 

In the General tab, select Show Response Time. 

 To define cursor appearance: 

In the General tab, select if you want a Block or Underline display. 

 To define GUI appearance: 

In the General tab, select Power GUI or Show Frame to display a "different" look of 

the work area. 

 To define the code page: 

In the General tab, select Host and PC Code Pages in the dropdown lists. 

 To specify the alternate size: 

In the General tab, select Enable and enter the Rows and Cols (columns) sizes. 

VT specific parameters 

 To define the numeric keypad mode: 

The Num Lock key toggles between numeric keys or arrow keys. 

In the General tab, select Numeric and Numlock. 

 To define the application keypad mode: 

The Num Lock key toggles between numeric keys or application keys. 

In the General tab, select Application and Numlock. 

ASCII specific parameters 

 To show the label line: 

Display a status line at the top and the bottom of the emulation screen. 
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In the General tab, select Label Line. 
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5. Defining Connections 

You can create different connections according to your needs. The connection 

parameters that you define will remain active only for the current session, unless 

you save them. You can also predefine terminal settings on your PC and then 

import them to PowerTerm WBT. 

After you saved your connection, you can modify its parameters, either from within 

the Connection Manager or by right-clicking the desired connection in the Session 

Manager. 

The default setup name is the name of the connection. Customized settings should 

be saved with a name other than its current name when the PowerTerm WBT 

session is running. 

You can also delete connections that are no longer in use. 

 To define a connection: 
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1. Open the Connection Manager and click Add. The New Connection dialog 

appears. 

 In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Add button. 

2. Select Ericom PowerTerm WBT – Terminal Emulator (or the name that was 

predefined by the OEM) and click OK. The PowerTerm Connection Properties 

dialog appears. 

3. Select the desired Language for the user interface. 

 Modifying this field will cause loss to any previously entered 

information. 

4. Select an emulation type from the Terminals list. 

5. Select the Session Type. 

6. Supply the relevant parameters. 

7. Select the desired Security to be employed in the connection. 

8. Customize the Terminal Setup. The property pages that will be displayed are 

determined according to the specified emulation type in the Connection 

Properties dialog. 

9. If desired, customize the Terminal GUI. 

10. If desired, customize the Terminal Keyboard. 

11. Type the Connection Name. This name will also automatically appear in the 

Use Terminal Configuration Setup field but can be changed if desired. 

12. Specify, if necessary, the Script name to be run on logon. 

13. Specify if necessary, in the Wait Before Connect (Sec) field how many seconds 

to wait before connecting to the host. 

14. Click OK. The new connection appears in the Connection Name list of the 

Connection Manager. 
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 To specify SSH Security parameters: 

 

1. Click Details in the PowerTerm Connection Properties dialog. The SSH Security 

dialog is displayed. 

2. Select the desired SSH Version. 

3. Specify the SSH properties. 

4. Click OK. The connection is now secure. 

 To create a connection with a predefined configuration: 

1. Open the Connection Properties dialog and click  adjacent to the Setup 

field. The Open Terminal Setup dialog appears. 

2. Select the desired configuration from the Terminal Setups List and click OK. 

 To modify connection parameters: 

1. Open the Connection Manager and select the desired connection. 

2. Click Edit. The Connection Properties dialog appears. 

 In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Edit button. 

3. Change the settings as desired. 
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4. Click OK. The modified settings are now in effect for the next emulation 

session. 

 To customize settings: 

1. Open the Connection Manager and select the desired connection. 

2. Click Edit. The Connection Properties dialog appears. 

 In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Edit button. 

3. Click the browse button in the Use Terminal Configuration section. The Open 

Terminal Setup dialog appears. 

4. Select the desired setup either from the Terminal Settings List or From Host 

(see "To import a terminal setup" below). 

5. Click OK. The selected name appears in the Setup Name field. 

6. Click OK. 

 To import a terminal setup: 

1. Open the Connection Properties dialog and click  adjacent to the Setup 

field. The Open Terminal Setup dialog appears. 

2. Click From Host. The Import Terminal Setup from Host dialog appears. 

3. Type the necessary IP address of the FTP server in the Host Name field. 

4. Type in the appropriate User Name if necessary. 

5. Type in the appropriate Password if necessary. 

6. Type in the appropriate Setup Name if necessary. 

7. Click OK. A notification message about the file being transferred appears 

followed by a progress bar. The imported Setup Name then appears in the 

Terminal Setups List of the Open Terminal Setup dialog. 

8. Select the imported terminal setup and click OK. 

9. Fill out all of the necessary fields (Host Name, Connection Name etc.) and 

then click OK. 

10. Select the newly defined session and click Connect. 

 In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Connect button. 

 To delete a connection: 

1. Open the Connection Manager and select the desired connection. 

 In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Delete button. 
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2. Click Delete. A confirmation notification is displayed. 

3. Click OK. The connection is deleted. 
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6. Manipulating the Desktop and 
Selecting Text 

PowerTerm WBT enables you to customize the PowerTerm WBT window by 

displaying or hiding desktop components and changing the display colors for 

different text attributes. The color attributes change according to the emulation 

type you have selected. 

This chapter also presents specific text selection techniques that you may find 

useful in different emulations. 

6.1. Manipulating Desktop Components 

Most components are displayed or hidden according to your selection in the Options 

menu. An alternative way is to use a floating menu with all the options. 

 To open the floating menu: 

Press <Ctrl>+<Shift>+<M> on the keyboard and select the desired action. 

 To show/hide the Menu bar: 

1. Select Options | Hide Menu. This conceals the Menu bar. 

2. Press <Ctrl>+<Shift>+<M> on the keyboard and select Restore Menu. The 

Menu bar is shown again. 

Or, 

Map a Soft button with the following PSL command: 

menu restore 

 To show/hide the Soft buttons: 

• Select Options | Hide Buttons. The menu option becomes Show Buttons. 

• Select again to redisplay the Soft buttons bar. 

 To show/hide the Status bar: 

• Select Options | Hide Status Bar. The menu option becomes Show Status Bar. 

• Select again to redisplay the Status bar. 

 To show/hide the Power Pad: 

• Select Options | Show Power Pad. The menu option becomes Hide Power Pad. 

• Select again to hide the Power Pad. 

 To show/hide the History Scroll bar: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 
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2. Click the Display tab. The Display property page is displayed. 

3. Select History Scroll Bar in the General section. 

4. Click OK. The PowerTerm WBT window is redisplayed with the history scroll 

bar. 

6.2. Manipulating Desktop Display 

 To change the display color of the PowerTerm WBT window: 

The color for the Normal attribute determines the color of the entire work area. The 

box above the Select Attribute parameter shows the result of your selections. The 

Select Attribute of the entire screen is generally Normal, for non-IBM emulations 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select the attribute for which you want to define foreground and background 

colors. Notice that the attributes change according to the emulation type you 

selected previously. 

4. In the Text area, select the color that you want to apply to the text 

(foreground) of the display. 

5. In the Background area, select the color that you want to apply to the 

background of the text. The preview box above the Select Attribute 

parameter shows the result of your selections. 

6. Click OK. 

 To disable/enable underline: 

If data is transmitted with the Underline attribute, you can disable the underline by 

clearing this parameter. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select/Clear Enable Underline as desired. 

 To disable/enable blink: 

You can choose whether to enable blinking of data, which was received from the 

host with the blinking attribute. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select/Clear Enable Blink as desired. 

 To reverse display colors: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 
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2. Click the Colors tab. The Colors property page is displayed. 

3. Select/Clear Enable Blink as desired. 

 To scale/unscale characters: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select/Clear Reverse Display Colors as desired. 

 To display a cursor ruler: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select Visible to display the cursor ruler. 

4. Select Crosshair/Horizontal/Vertical appearance of the cursor ruler. 

 To specify dimensions of screen: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select if you want 80 or 132 Columns or enter your own number of columns 

in Other. 

4. Select how many Lines per screen you want, from the dropdown list. 

5. You can also specify if you want to Limit the font size. 

 To specify pace at which data is displayed: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select if you want Smooth or Jump scrolling. 

4. Select Jump scroll speed from the dropdown list. 

 To work with VT soft fonts: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select Enable soft fonts. 

 To set tabs in the work area: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Tabs tab. The Tabs property page is displayed. 

3. Click in the ruler where you want to set a tab. A 'T' will appear. 
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4. Click a 'T' to clear it. 

5. You can also specify a certain interval between the tabs by entering a 

number and then click Set Every. 

 To specify ANSI/Attribute colors: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select your preference in the Default Colors drop down list. 

 To set column separator: 

For IBM 5250 display emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Colors tab. The Colors property page is displayed. 

3. Select Column Separator. 

6.3. Selecting Text 

6.3.1. General selection techniques 

 To select a word: 

In the work area, just click a word to select it. 

 If the Automatic Copy option in the Edit menu is active (default), selecting 

text also copies the selection to the clipboard. 

 To select full lines: 

1. Point to the first line that you want to include in the selection. 

2. Press <Shift> on the keyboard and drag the mouse to the last line you want 

to include in the selection. 

 To select a string: 

1. Point to the first character that you want to include in the selection. 

2. Drag the mouse to the last character that you want to include in the 

selection and release the mouse button. 

 To select the entire screen: 

Select Edit | Select Screen. 

 To paste copied data: 

Equivalent to actually typing the contents of the clipboard on the host screen. 

Right-click or select Edit | Paste. The host data stored on the clipboard is pasted to 

the work area. 
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6.3.2. VT emulations' specific techniques 

 To select a block: 

A block is any rectangular section or the work area. 

1. Point to the corner of the block that you want to include in the selection. 

2. Press <Ctrl> on the keyboard and drag the mouse to the opposite corner of 

the block you want to include in the selection. 

 To select a menu entry: 

Double-clicking on a word sends that word to the host once you have pressed 

<Enter> on the keyboard. Use this feature to select a menu entry. For example, if 

the emulation screen displays the menu of an application residing on the host, click 

a menu entry to activate the program that the menu entry represents. 

6.3.3. IBM emulations' specific techniques 

 To select a block: 

A block is any rectangular section or the work area. 

Point to one corner of the block and drag the mouse to the opposite corner of the 

block you want to include in the selection. 

 To activate light pen support: 

For IBM 3270 emulations only. 

Any double-click on the screen is equivalent to touching the screen with a light pen. 
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7. Keyboard Settings 

PowerTerm WBT enables you to map WBT keys to host keys in order to emulate the 

host terminal keyboard.  You can also modify your keyboard to behave in certain 

ways such as having the Backspace key send either backspace or delete, or letting 

the Numpad send a comma. 

7.1. Mapping Keys 

 

 To map a WBT key: 

1. Select Options | Keyboard Map. The Keyboard Mapping dialog appears. 

2. Drag a key from the upper terminal keyboard to a WBT key on the lower 

keyboard. 

• Click the <Shift> or <Ctrl> keys on the terminal keyboard (in the dialog) to 

display additional key functions. For example, if you click the <Shift> key, 

the alphabet keys on the terminal keyboard are displayed in upper case. You 

can then map (drag) these keys to your WBT keyboard keys. 

 To assign a script command to a WBT key: 

1. Select Options | Keyboard Map. The Keyboard Mapping dialog appears. 
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2. Right-click a key on the WBT keyboard that you want to assign a command 

and select Enter Script Commands. The PC Button dialog appears. 

3. Enter the desired script command and click OK. The WBT key has now been 

assigned a script command. 

 To map combinations of keys that include Alt, Ctrl, and Shift: 

• Click the <Alt>, <Ctrl> or <Shift> key (or any combination of them) on your 

PowerTerm WBT keyboard. Then map keys by following the procedure 

described previously. 

• Click the required <Alt>, <Ctrl> or <Shift> key (or any combination of 

them) to view the mapped keys. 

 To cancel a keyboard key definition: 

Drag the WBT key definition that you want to cancel to . This restores the 

default function of the WBT key. 

 To replace a WBT key with another WBT key: 

PowerTerm WBT enables you to move the functionality of a mapped WBT key to 

another WBT key. For example, you can drag the F6 key on the WBT keyboard to 

the spacebar on the WBT keyboard to give it F6 functionality. 

• Drag the desired WBT key onto the WBT key that it will replace. The 

functionality of the WBT key has been replaced. 

• Drag the original key back to its initial position to reverse the action. 

 To copy a WBT key to another WBT key: 

PowerTerm WBT enables you to copy the functionality of one WBT key to another 

WBT key. 

1. Select the WBT key whose function you want to copy to the required WBT 

key and right-click Copy. 

2. Select the WBT key to where you want to copy the function and right-click 

Paste. Both keys now have the same functionality. 

 To restore the default keyboard mapping of all mapped keys: 

Click Defaults in the Keyboard Mapping dialog. 

7.2. Saving and Opening Keyboard Mapping 
Settings 

PowerTerm WBT enables you to save keyboard-mapping settings separately in the 

registry or to a specified file and open them at a later date. 
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 To load the keyboard mapping settings: 

1. Select File | Open Keyboard File. The Open Keyboard Setup dialog is displayed: 

 

2. Select the required keyboard settings from the list or select From File and 

browse for the required keyboard setting. 

3. Click OK. Parameters defined in the selected keyboard settings are now 

applied to the current session. 

 To save keyboard mapping settings: 

1. Select File | Save Keyboard File. The Save Keyboard Setup dialog is displayed: 

 

2. Enter a Keyboard Setup Name. 

3. Select To File if you want to save the keyboard setup to a file rather than to 

the registry. 

4. Click OK. The keyboard mapping registry settings are saved with the 

specified setup name. 

7.3. Keyboard Behavior 

You can customize your keyboard. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 
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3. Select the behaviors you desire. 

 To issue sounds: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Key Click to issue a click sound when you press a key on the 

keyboard. 

4. Select Margin Bell to issue a bell tone when the cursor reaches the right 

margin. 

5. Select Warning Bell to issue a bell tone when receiving the "bell" (ASCII 7) 

character. 

 To send a comma instead of decimal: 

Change the Numerical pad's decimal. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Numpad Decimal sends Comma. 

 To lock alphabet keys in uppercase: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Caps (Unix). 

 To lock alphabet and numerick keys in shift setting: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Shift. 

 To reverse the Caps Lock: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Reverse (Win). Pressing Shift on your keyboard reverses the caps 

operation. 

 To keep Caps Lock mode On: 

You can turn Caps Lock Off in a different application and keep it On in PowerTerm. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Always On. 
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 To send a delete instead of backspace: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Backspace Key Sends. 

 To automatically repeat a character: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Auto Repeat. 

4. Continuously press the desired key on the keyboard. 

 To display the keyboard input: 

Display the keyboard input on your screen even if the host system does not echo 

your input. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Local Echo. 

 To disable the Windows Alt sequence: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Use Emulator Alt Keys. 

 To issue an LK450 Digital keyboard: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Select Use VT Keyboard Mode. 

 To issue an Answerback message: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is displayed. 

3. Specify the message in the text field. 

4. Click Clear to delete the message. 

5. Click Conceal to hide the message. 

6. Select Auto Answerback to send the message automatically at connection to 

the host. 
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8. Soft Buttons and Power Pad 

Along the bottom of the PowerTerm WBT window are twelve programmable Soft 

buttons, by default named from F1 to F12. These can be renamed and programmed 

to execute customized scripts or to send individual commands to the host. Send the 

programmed command to the host by clicking the desired Soft button. For example, 

clicking the F1 Soft button is equivalent to sending F1 to the host. 

The Power Pad is a floating keypad that contains buttons, which can be 

programmed to execute customized PSL scripts. You can also change their names 

and adjust the number of buttons displayed in the Power Pad. You can display a 

maximum of 10 rows and 10 columns in the Power Pad. The default number of 

buttons is 9 rows and 4 columns. 

Power Pad buttons are named by default F1, F2, F3 and so on, with a few default 

function names, such as Clear, Enter, and Insert. For example, clicking on the F1 

button is equivalent to sending F1 to the host. 

Soft buttons settings are saved together with the Power Pad settings in the registry. 

PowerTerm WBT enables you to save your Power Pad settings in separate registry 

settings and open them at a later date. 

 To program Soft buttons: 

1. Right-click the Soft button that you want to program. The Function Button 

dialog is displayed: 

 

2. Enter the function description (the new name that will appear on the 

button). 

3. Enter the Script Command to be run by this button. 

4. Click OK. The Soft button is now displayed with its new name. Clicking on 

the Soft button will execute the newly defined script command. For more 

information, see Scripts. 

 To program the Power Pad: 

1. Select Options | Show Power Pad or click . The Power Pad is displayed. 
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2. Right-click the Power Pad button that you want to program. The Power Pad 

Button dialog is displayed: 

 

3. Enter Button Description (the new name that will appear on the Power Pad 

button). 

4. Enter the Script Command to be run this Power Pad button. More script 

commands can be entered separated by semicolons. 

5. Click OK. Clicking on the Power Pad button will execute the newly defined 

script command. For more information, see Scripts. 

 To adjust the number of buttons in the Power Pad: 

1. Select Options | Power Pad Setup. The Power Pad Setup dialog is displayed: 

 

2. Click on the dropdown box to select the number of rows or columns that you 

want the Power Pad to contain. 

3. Click OK. The Power Pad is displayed with the specified number of rows and 

columns.  

 To save your Power Pad settings: 

1. Select File | Save Power Pad Setup. The Save Power Pad Setup dialog is 

displayed: 
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2. Enter a Power Pad Setup Name. 

3. Select To File if you want to save the Power Pad setup to a file rather than to 

the registry. 

4. Click OK. The settings will be saved with the specified name. 

 To open predefined Power Pad settings: 

1. Select File | Open Power Pad Setup. The Open Power Pad Setup dialog is 

displayed: 

 

2. Select the required setup from the Settings List or select From File and 

browse for the Power Pad setup file. 

3. Click OK. Parameters defined in the selected setup are now applied to the 

current session. 
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9. Printing 

The Printer property page and Advanced Printing setup dialogs enables you to 

define printing parameters. 

Printing can be done in Text mode or in Graphic mode, as well as in Host and UTF-8 

data conversion. For IBM 5250 printing emulations, Host printing is enabled. 

There are two different modes with different fields enabled: 

• Text mode is designated in the Printer property page by setting the two data 

conversion combo boxes (Print Screen and Slave Printer) to None. 

• Graphics mode is graphic printing. It is designated in the Printer property 

page by setting the two data conversion combo boxes (Print Screen and 

Slave Printer) to Graphics. 

9.1. Configuring Printer Parameters 

 To define printer parameters: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. The Printer property page is displayed. 

3. Select the parameters that you require. 

 To define advanced printer parameters: 

Ignore, when selected, applies default values. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. The Printer property page is displayed. 

3. Click Advanced Printing. The Advanced Printing Setup dialog appears. 

4. Select the parameters that you require.  

 To select a device or network to be the printing output channel: 

NOTE When Graphics is selected for Print Screen Data Conversion/Slave Printer 

Data Conversion, the Print Manager is automatically used as the printing 

output channel, regardless of the Print Device that has been selected. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and from the Print Device dropdown list select Device 

or Network. 

3. Enter your print communication port in the Device Name field and click OK. 

 To add a form feed after each printing job: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Use Form Feed. 
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 To add a line feed after each carriage return: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select CR->CRLF. 

 To convert line graphic to text: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Print Line Graphics as Text. 

 To specify the job delimiter character: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Slave Printer Job Delimiter. 

 To delay print closing: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Delay for Print Closing. 

 To configure IBM 5250 host print transform: 

NOTE Relevant when you print in Text mode to a specific printer such as bar-

code. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. 

3. Select a Text mode for Slave Data Printer Conversion. 

4. Click Advance Printing. The Advanced Printer Setup dialog appears. 

5. Select Enable AS/400 Host Print Transform and select the parameters you 

require. 

 To specify page type for text printing: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. 

3. Click Advance Printing. The Advanced Printer Setup dialog appears. 

4. Select the desired page type from Page Type for Text Printing dropdown list. 

 To change page orientation: 

Default orientation depends on your printer's settings. The options are: Ignore, 

Portrait and Landscape. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. 

3. Click Advance Printing. The Advanced Printer Setup dialog appears. 
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4. Select desired Orientation in the dropdown list. 

 To specify printing margins: 

Printout margins are the space between the edge of the printout page and the 

border of the printing. Margins of the print output can be customized according to 

your specific needs. Modifying the top and left margins will determine the position 

at which printing will begin. 

5. Select Terminal | Setup. The Terminal Setup dialog appears. 

6. Select the Printer tab. 

7. Set the Data Conversion Type to Graphics. 

8. Click Advanced Printing. The Advanced Printer Setup dialog appears. 

9. In the Margins field, type your requirement. For example, to shift the margin 

1 cm type in 100. 

10. Select Auto/Auto (Printer Sizes) for the CPI value to enable the right margin 

field. 

11. Select Auto/Auto (Printer Sizes) for the LPI value to enable the bottom margin 

field. 

 To use the host’s CPI value: 

For IBM 5250 Printer emulations only. 

12. Select Terminal | Setup. The Terminal Setup dialog appears. 

13. Select the Printer tab. 

14. Set Slave Printer Data Conversion to None. 

15. Click Advanced Printing. The Advanced Printer Setup dialog appears. 

16. Select the correct printer. 

17. Select Use Host Value in the CPI field. 

18. Check that you have the relevant .ped file. 

19. Verify that Enable AS/400 Host Print Transform is cleared. 

 To automatically calculate the CPI: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. 

3. Set Slave Printer Data Conversion to Graphics. 

4. Click Advanced Printing. The Advanced Printer Setup dialog appears. 

5. Set CPI to Auto. 

6. Select the desired Page Type for Text Printing. 
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 To assigne an LU/Device name to the print session: 

For IBM emulations only. 

1. In the Configuration Manager, select your IBM printing emulation. 

2. In the LU/Device Name field specify the name for the session. Maximum 

length is 8 characters for LU name and 10 characters for Device name. 

When using multiple sessions enter the name with a plus, for example 

"John+". Each session will be automatically assigned a new name. (In our 

example the first session will be John1, the second John2 and so on.) 

3. Enter the other parameters and click OK. 

9.2. Sending Escape Sequences 

An escape sequence is a series of characters used to trigger some sort of command 

state in computers and their attached peripherals. A text editor (like vi) can display 

lines of text in a terminal window by simply writing those characters to the window. 

However, in order to perform such functions as moving the cursor, making text 

brighter, or erasing part (or all) of the screen you must send escape sequences: 

special strings of characters meant to control the terminal. A terminal observes 

each input character and, if it's part of an escape sequence, it interprets that 

character string as a command instead of displaying it as text. 

You can record the necessary escape sequences in a number of ways:  

• .prt files  

• .ped files  

• Via keyboard mapping 

9.2.1. Printer Configuration Files (.prt) 

The Printer Configuration Files (.prt) enables the user to manipulate the printer 

output (for example: bold, italic, underline). Typically you would use the escape 

sequences in the PowerTerm supplied prt file. There are circumstances that would 

warrant you referencing alternative escape sequences. Both are explained below: 

Typical Use 

1. Verify the existence of the .prt file in the folder where ptw32.exe resides. 

2. Create a PSL file with the following name: open-printer file 

yourfilename.prt 

Referencing alternative escape sequences 

There are times when the printer will print an unnecessary escape sequence. To 

avoid this situation, the following solution will enable you to have the emulation 

program reference an alternative sequence, thus replacing it with a more effective 

sequence.   
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NOTE The source.prt and customized prt files be located in the same folder as 

the PowerTerm product executable. 

1. Edit the source.prt file in the following manner: blank = X1B 

escapesequence (which the emulation should ignore)  

2. Save the file.  

3. Create the file ignore.prt with the following line: blank =  

4. Save the file ignore.prt to the PowerTerm folder.  

5. Create a PSL file with the following line: open-printer file ignore.prt  

6. Save the PSL file to the PowerTerm folder.  

7. Edit the PowerTerm InterConnect shortcut by adding the newly created PSL 

file name after the exe (preceded by a space). 

8. Double-click the shortcut icon. 

Modifying Printer Settings via the .PED file 

The .ped files are very useful when you want to modify a particular print setting: 

page orientation, LPI (Lines Per Inch) or CPI (Characters Per Inch). 

The .ped files are located in C:\Program Files\Ericom Software\PowerTerm\printers 

You must insure that the Printer Properties Page parameters are set correctly 

before applying the .ped settings: 

To Print Screen: 

1. Select Terminal | Setup. The Terminal Setup dialog is displayed. 

2. Select the Printer tab. The Printer properties page is displayed. 

3. Set Print Screen Data Conversion to "None". 

To use Slave Printing: 

1. Select Terminal | Setup. The Terminal Setup dialog is displayed. 

2. Select the Printer tab. The Printer properties page is displayed. 

3. Set Slave Printer Data Conversion to "None". 

NOTE If the value "Graphic" is left in the above fields then OS Print manager 

takes control and decides how to print the job. 

To change the default: 

1. Open up the desired PED file in a text editor such as Notepad. 

2. Locate the section entitled "[Printer Escapes]". 

3. Add a line starting with "init = ". 

NOTE This will initialize the printer for this specific setting which may be 

overwritten by a subsequent modification in the user interface.  
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4. Type list of desired escape sequences (separating each one with a ";"). 

5. Save the PED file. The new escape sequences will be applied to future 

outputs. 
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10. Scripts 

PowerTerm WBT enables you to create scripts for automating tasks. For example, 

you can create a script to login to a PowerTerm WBT session, execute a file, display 

a message, etc. Scripts can be run upon startup or during a PowerTerm WBT 

session. They can be written in any standard text editor, like Notepad, and are 

saved with a .psl extension. This chapter describes how to create, edit, run, save 

and activate script in PowerTerm WBT. 

The PowerTerm Script Language (PSL) is PowerTerm's own programming language. 

For a full description of the different PSL commands, see the "PowerTerm Script 

Language Reference". You can find exclusive PowerTerm PSL commands for 

PowerTerm WBT in the Appendix “PSL Commands” at the end of this annual. 

PowerTerm WBT provides the following script options: 

• Create a script, creates a script to run upon startup or at any time during a 

PowerTerm WBT session. 

• Edit a script, edits and modifies an existing script file. 

• Record a script, creates a script by recording all the actions that you perform 

in the PowerTerm WBT window. Actions can include selecting a menu option, 

typing an entry on the screen, making selections in a dialog, and so on. 

• Run a script, runs specific scripts or individual commands, upon startup, 

connection to a host, or during a PowerTerm WBT session, to automate 

specific tasks, you can only run saved scripts. 

• Activate a recorded script, executes a non-saved script from the current 

memory. 

• Save a recorded script, saves your script to be used at a later date. 

• Assign scripts, to the Power Pad and Soft buttons. 

 To create a script file: 

1. Select Script | Edit Script. The Edit Script dialog appears. 

2. Type a name for the new script in the script Name text box. 

3. Click Edit. The PowerTerm WBT Script Editor appears. 

4. Type the script and slick Save from the File menu to save your new script. 

The next time you run or edit a script, this new file will appear in the Scripts 

List. 

5. Select File | Exit to exit the editor. 

 To edit a script file: 

1. Select Script | Edit Script. The Edit Script dialog appears. 

2. Select the required script file in the files list. 
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3. Click OK. The PowerTerm WBT Script Editor appears. 

4. Edit the script and click Save from the File menu to save your changes. 

5. Select File | Exit to exit the editor. 

 To record a script: 

1. Click  or select Script | Start Script Recording. The menu option changes 

to Stop Script Recording. 

2. Perform the manual operations that you want to record. For example, select 

a menu option, enter parameters in a dialog, or type a password. 

3. Select Script | Pause Script Recording if you do not want to record certain 

operations. The script recording process pauses and the menu option 

changes to Continue Script Recording. 

4. Select Script | Continue Script Recording to resume the recording. 

5. Click  or select Script | Stop Script Recording when you have performed 

all the operations to be stored in the script. You can also save the script that 

you just created, so that you can run it at any time to repeat the operations. 

 To run a specific script: 

1. Select Script | Run Script. The Open Script Setup dialog appears. 

2. Double-click the script that you want to run. The selected script is executed. 

 To run a script at startup: 

Standard edition 

1. Open the Connection Manager and select the appropriate connection. 

2. Click Edit. The Connection Properties dialog appears. 

 In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Edit button. 

3. Click  adjacent to the Script Name field. The Open Script dialog appears. 

4. Select the desired script from the Script List and click OK. The selected name 

appears in the Script Name field. You can also type the script name without 

browsing if you already know it. 

5. Click OK. The designated script will be activated upon startup of this session. 

Desktop edition 

1. Select File | Save As Icon. The Save As Icon dialog appears. 

2. Click OK. 

3. Select the icon on your desktop. 
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4. Right-click Properties. The Shortcut to ptw32.exe Properties window is 

displayed. 

5. In the Target area, add a space after the .exe file name and then type the 

name of the required script (.psl) file. You can also add parameters to the 

script file. These determine communication parameters, for example the 

name of the host to which you want to connect, or the Port number. 

6. In the Target area, add a space after the .psl script file and then type the 

required parameters. Parameters should be separated by a space. Example: 

7. \PTW32\PTW32.EXE COMM.PSL 1 9g00 xonxoff 

 To run a script file during a PowerTerm WBT session using Soft buttons: 

Click the Soft button that has the desired script assigned. The script is executed. For 

more information, see Soft Buttons and Power Pad. 

 To run a script file during a PowerTerm WBT session using the Power Pad: 

Click the Power Pad button that has the desired script assigned. The script is 

executed. For more information, see Soft Buttons and Power Pad. 

 To run a script file upon connecting to a host: 

1. Select Script | Run Script. The Open Script Setup dialog appears. 

2. Select the desired file. 

3. Click OK. The designated script is executed upon connection. 

 To run individual script commands: 

1. Select Script | Script Command. The Script Command dialog appears. 

2. Type the name of the script command you want to run. Include parameters 

if necessary. 

3. Click OK. The specified script command is executed at once. 

 To activate a recorded script: 

Select Script | Activate Recorded Script (<Alt>+<F9>). The script currently recorded 

in memory is now activated. 

 To save a recorded script: 

1. Select Script | Save Recorded Script. The Save Script Setup dialog appears. 

2. Enter a Script Setup Name. 

3. Click OK. The script will be saved with the specified name. 
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11. Session Manager 

PowerTerm WBT standard edition features a Session Manager that provides quick 

access to a list of user-configured sessions. The list includes only non-active 

sessions and you can in an easy way determine which of the non-active sessions 

you want to activate. The Session Manager enables you to conveniently modify the 

connection parameters or setup of a desired connection. 

Activated sessions are also represented by lettered icons on the toolbar. Clicking on 

the icon will bring that session to the foreground. 

 

 To activate all or some of the sessions: 

1. Select File | New Terminal Window, or click . The PowerTerm Session 

Manager dialog appears. 

2. Select the desired session(s) to activate and click Activate Session. The 

selected emulation session is displayed. 

 To modify the connection parameters or setup of a desired connection in 
the Session Manager: 

When modifying connection parameters, the Connection Name cannot be modified. 

1. Select the desired connection and right-click the appropriate action. 

2. Make the desired changes and click OK. 
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Appendix A PSL Commands 

The PowerTerm Script Language (PSL) is PowerTerm's own programming language. 

For a full description of the different PSL commands, see the "PowerTerm Script 

Language Reference". Here you can find exclusive PowerTerm PSL commands for 

PowerTerm WBT. 

 

Activate-Connection 
Activates a predefined connection. 

 

Syntax 

Activate-Connection "connectionName" 

 

connectionName Specifies the connection to be activated. 

 

Returns 

N/A 

 

Notes 

This command, as all commands in the Windows CE environment, is case-sensitive. 

Example 

Activate-Connection "telnet2" 
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About Ericom 

Ericom® Software is a leading provider of Enterprise-Wide Application Access and 

Delivery Solutions. Since 1993, Ericom has been helping users to access enterprise 

mission-critical applications. More than a decade later, Ericom continues to focus on 

its core business, while enabling access to applications running on a broad range of 

Microsoft® Windows® Terminal Servers, Virtual Desktops, legacy hosts and other 

systems, and providing concrete business value by helping organizations realize the 

benefits of their IT investments. With offices in the United States, United Kingdom, 

EMEA, India and China, Ericom also has an extensive network of distributors and 

partners throughout North America, Europe, Asia and the Far East. Our expanding 

customer is more than 30 thousand strong, with over 6 million installations. 

 

 

 

 

 

 

For more information on our products and services, contact us at the location 

nearest to you or visit our Web site: http://www.ericom.com 

 

North America UK and Western Europe International 

Ericom Software Inc. Ericom Software (UK) Ltd. Ericom Software Ltd. 

231 Herbert Avenue, Bldg. #4 11a Victoria Square 8 Hamarpeh Street 

Closter, NJ 07624 USA Droitwich, Worcestershire Har Hotzvim Technology Park 

Tel +1 (201) 767 2210 WR9 8DE United Kingdom Jerusalem 91450 Israel 

Fax +1 (201) 767 2205 Tel +44 (0) 870 2000 176 Tel +972 (2) 591 1700 

Toll-free 1 (888) 769 7876 Fax +44 (0) 870 2000 179 Fax +972 (2) 571 4737 

Email info@ericom.com Email info@ericom.co.uk Email info@ericom.com 
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